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User Guide: Rules for the Creation of a Bill of Material (BOM) & Router
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1. BILL OF MATERIALS (BOM)
A Bill of Materials is created by the engineer and maintained in the Business System Database (BSD). It generally consists of Top Level, Main Assembly and Sub Assembly levels, depending on complexity of the product. 

1.1  Purpose:

The BOM is the information that tells Production what is needed to build a product.  It is critical that it be correct and all-inclusive. 

Therefore, if it really matters that a certain item should be used with a model, then the item should be included on the BOM. A good example might be the shipping cases used in the Vibration Group. The blue quality box and its foam cutout are listed on the BOM, but the final cardboard shipping box is not included, since it is not critical which cardboard shipping container is used.
1.2 Bill of Materials (BOM) Structure:
1.2.1 General BOM Structure: 

The general structure is as follows:


Top Level (model number)



ENG-5555-XX Part Number (used when the BOM requires special approval prior to modification)



Main Assembly Part Number



Part Numbers (mass, base, connector, screws, washers, resistor, front panel, etc.)



Consumable Part Numbers (epoxy, solder, wire, software, etc.) (qty. = 0)



Assembly Procedure Number(s) (z-document; qty. = 0)



Assembly Fixture(s) (qty. = 0)



Special Calibration Fixture(s) (qty. = 0)



Outside process part numbers (see section 1.2.3 Outside Services Process below)



Sub Assembly Number (amplifiers, element packages, etc.)



Part Numbers (mass, connector, screws, washers, resistor, front panel, etc.)



Consumable Part Numbers (epoxy, solder, wire, etc.) (qty. = 0)




Assembly Procedure(s) (qty. = 0)




Assembly Fixture(s) (qty. = 0)




Special Calibration Fixture(s)



Specification Number



Document Number(s) required by E-NMI (SM1008) (installation dwg, outline dwg, wiring diagram, etc.)


Accessory Part Number(s) (cables, studs, supplied software, seals, etc.)
Required explosive atmosphere documentation (Take out a part number for scanned certificate)



Manual Part Number or Manual Sub Assembly Part Number



Special Packaging Part Number(s)

After the BOM is approved by the necessary individuals, the Drafting Department turns on the “rev tracking” flag for the model, main assembly and any sub-assemblies (DD02).

In an effort to insure the BOMs/Routers are accurate, the Production Department has a formal mechanism for providing feedback and tracking the errors. If Production finds an error, this is documented on an Material Disposition Report/Deviation Notice (also known as Waiver) Form (QA020). 

Note: Quantities and Bubble Numbers must be associated with each component shown on the associated assembly drawing as well as all fixtures. This is explained later in this procedure in the Creating the Router / Operation Steps from Scratch: section.
Note: When a blank line item is needed, “NA” will be used as the item number.

Note: CE Certificates, Certificates of Conformance and other similar documentation, which are defined on a per order basis, do NOT get included on the BOM.

Note: If every product gets a certain item when the product is shipped to the customer, a procedure can be written and filed into logistics in lieu of including the item on a BOM. 

1.2.2 BOMs that are NOT to be Modified without Authorized Approval: 

BOMs that are NOT to be modified without obtaining prior authorized approval shall always include the ENG-5555-XX as the first part number. This part number is to be included on Operation Step 5 of the Router with BOM sequence number set to 1. See below for a partial list of valid numbers. The complete list will be found within the BSD using an Items Filter.

ENG-5555-01: The description states “DO NOT MODIFY WITHOUT ENG APPROVAL” – General Engineering Approval.

ENG-5555-02: The description states “Scheduled No Mods w/o Notified Body Approval” – ATEX/Explosive Atmosphere Scheduled items.  “ATEX” or “EXPLOSIVE ATMOSPHERE” products, are manufactured and approved for use in potentially explosive environments and therefore cannot generate any electrical sparking or shorting.  Changes to these products could impact certifications and therefore requires approval prior to any changes.

ENG-5555-03: The description states “Related No Mods w/o Authorized Approval” – ATEX/Explosive Atmosphere Related items.    “ATEX” or “EXPLOSIVE ATMOSPHERE” products, are manufactured and approved for use in potentially explosive environments and therefore cannot generate any electrical sparking or shorting.  Changes to these products could impact certifications and therefore requires approval prior to any changes.

ENG-5555-04: The description states “PROGRAM-NO MODS W/O CUSTOMER APPROVAL” – Program Models Only.  “Program” products are manufactured for use in aerospace and/or defense or equivalent applications which are subject to customer specification and contractual requirements.  Changes to this product must be approved to ensure the customer and contractual requirements are still being met.

ENG-5555-05: The description states “EXPORT LICENSE REQUIRED” – ITAR Models.  “ITAR” product is product which is unique to a Military application (not COTS) and information related to such product which is restricted from distribution to any non-US citizen, including export out of the US.

ENG-5555-06: The description states “NO MODIFICATIONS W/O CUSTOMER APPROVAL” –  “Customer Controlled” product is product that must meet the requirements of a customer specification.  Changes to this product must be approved to ensure the customer requirements are still being met.  Customer controlled item examples are Ono Sokki, GE, etc.

ENG-5555-07: The description states “EXPORT CONTROLLED INFORMATION”  “Export Controlled Information” product is product and information related to such product which is restricted from distribution to any non-US citizen, including export out of the US.  This product is similar to ITAR but carries more strict regulations about the distribution of such product and information.  
1.2.3 Outside Services Process

When creating a new part number for an outside service, the part number should begin with the noted prefix. 

The new outside services part number must be structured in the BOM to the parent item that requires the outside service. Also, the new prefixed part number must be created as a purchased part.

ASxxxxx-xx – Assemble components (e.g., ASPSHS19 connector or AS100-6901 OST pellet)

BLxxxxx-xx – Blanks of Materials or Balancing

CBxxxxx-xx – Cable assembly per drawing

CLxxxxx-xx – Cleaning

DBxxxxx-xx – Deburr

ETxxxxx-xx – Engrave

EPxxxx-xx – Electroplate / Electropolish

GRxxxx-xx – Grinding

HCxxxxx-xx – Hard coat part per drawing

HTxxxxx-xx – Heat Treat per drawing

JTxxxxx-xx – Just in time transactions

LKxxxx-xx – Leak testing

MDxxxx-xx – Molding

PCxxxxx-xx – Powder coat per drawing

PLxxxxx-xx – Plate (anodize) per part drawing or main assembly

PTxxxx-xx – Paint

RKxxxxx-xx – Rokide (ceramic coating)


SSxxxxx-xx – Silkscreen per drawing


TCxxxxx-xx – Turning per drawing


TSxxxxx-xx – Testing


RVxxxxx-xx – Random Vibration Testing

Wxxxxx-xx – Winding

WSxxxx-xx – Weld/Solder/Braze per drawing

1.3 Bill of Materials (BOM) Creation:

A list of materials needs to be generated for each assembly (Top Level Model, Main Assembly and Sub-Assemblies). 
Note: If you are creating a BOM for a new assembly, the assembly’s “Material Status” field on the “Controls” tab on the “Items” form in the BSD should have been set to “Slow Moving” by default. The MPS Flag on the “Planning” tab on the “Items” form will automatically be checked to prevent demand from showing in MRP. 
Note: If you are revising a BOM, check the “ECO” flag near the top of the “Items” form. This causes the material status field to change to “Slow Moving” to prevent planning from releasing jobs. When the BOM/Subassemblies/detail dwg/Router has been approved, Drafting will check the “Design Release” flag on new items, or the “ECO” flag on revised Items when everything is released to allow MRP to drive requirements.

1.3.1 Procedure for BOM Creation
The following procedure provides a basic outline for creating the assembly’s list of materials.

Step 1: Open the “Current Operations” form in the BSD:
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Figure 1: Blank Current Operations Form
Step 2: Enter the assembly you want to add materials to in the “Item” field, then click the “Magnifying Glass” icon to retrieve the item from the database. 
Note: The assembly must already exist in the database in order for you to add materials to it. Refer to EN1006 for creating new items.
Step 3: In the “Operation” field, enter “5” (or select “5” from the pull-down menu where available).

Note: As a guideline, all materials and fixtures are issued in Operation 5.

Note: Material associated with outside services should be issued at the operation where the service is performed.
Note: Accessories that are stored in a final inspection location should be issued at the final inspection operation.

Step 4: In the “WC” (work center) field, enter the appropriate inventory work center [e.g., DIC01 (central inventory), DIC02 (HCD inventory), DIC03 (Micro inventory), MS1090 (PMC inventory), or HIC01 (Halifax central inventory)], depending on who will issue the jobs for assembly. [Additional IC (inventory control) work centers may be added over time.] Select appropriate WC from pull-down menu.
Step 5: Click the “Save” icon.
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Figure 2: Populated Current Operations Form
Step 6: Click the “Materials” button to see the linked “Current Materials” form.
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Figure 3: Current Materials Form with U/M Pull-down Menu
Step 7: In the “Material” field, enter the part number of material (or select using the pull-down menu; use a partial number to limit search). 
Note: The item must already exist in the database in order for you to add it to the BOM.
Step 8: The “Type” field on the “Materials” tab will default from the items form. This should only be changed to Fixture when adding a fixture to an assembly bom and the item is coded as material on the items form. The “Lot Quantity” flag must also be set when fixture is used.
Step 9: In the “Quantity” field on the “Materials” tab, enter the quantity required. (For consumable expense items, such as solder, ribbon wire or epoxy, as well as fixtures and documentation, enter “0”.) 
Step 10: Under the “Quantity” field on the “Materials” tab, be sure the “Unit” or “Lot Quantity” option is selected, based on the following types of material:
· If Unit is selected, the system multiplies the “Quantity” field value by the released quantity of the operation to derive the actual quantity needed.

· If Lot Quantity is selected, the system considers the value entered into the “Quantity” field as the actual quantity needed.
Note: Outside Services fall under the “Other” material type, quantity per defaults to per lot.  Quanty per may need to be changed to per unit based on purchasing contract.
Step 11: In the “U/M” field on the “Materials” tab, enter the unit of measure. The “U/M” field defaults to the value entered on the “Items” form for the specific item number being used as material for the assembly. Normally, the “U/M” field is not changed unless there is a significant difference between the stocking U/M and the usage U/M. To use an alternate U/M, select from the pull-down menu as shown below. 

Note: There are special circumstances for unit of measure. For pre-measured items such as tubing, wire and cable, a unit of measure of piece (PC) should be selected. These items should not be identified with a unit of measure of each (ea) because supply chain could interpret (ea) as feet.

Step 12: On the “Current Materials” form, select the “References” tab. 
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Figure 4: Current Materials Form, Reference Tab
Step 13: In the “Bubble Number” field on the “References” tab, enter the “bubble number” associated with this part on the Main Assembly Drawing. For fixtures, enter a “bubble number” that begins with the letter “F” (F1, for example). Leave this field blank for procedures and other non-drawing items. 

Note: “Bubble numbers” should match the “bubble numbers” used on all other BOMs that list the same assembly procedure(s), especially for expendable items such as epoxy, wires, etc.
Step 14: Click the “Save” icon.

Step 15: Repeat this series of steps until all of the materials have been entered for all appropriate assemblies needed for the model.

This completes the initial creation of the BOM. 

2. ROUTERS

A router is created by the engineer and maintained in the Business System Database (BSD). It consists of a simplified set of operations required to build the model.

Initial approval of the router is done at the same time as the BOM approval and is documented with the signing of the BOM.

2.1 Routers / Operation Steps Structure:

2.1.1 General Router/Operation Steps Structure

The general structure is as follows:

Operation 5: For routers that have material issued from a central inventory location, set:
· Check “Use Fixed Schedule” box

· Fixed Schedule Hours = 24
· Move Hours = 0
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Figure 5: Current Operations Tab with "Use Fixed Schedule" checked
When required, apply Special “Do Not Change” Codes. See section 1.2.2 BOMs that are NOT to be Modified without Authorized Approval: in Bill of Materials (BOM) Structure: section.
Operation 10: Starting Work Center [Include major assembly steps taken, cal procedures (ATs)] (see section 2.1.5 Calibration Steps)
Items that require lot tracking and are on the BOM with 0 quantity must be manually lot tracked. This includes but is not limited to epoxies and solders, even though they may be checked as “lot tracked” in the BSD.  Indicate the item description and leave space for the technician to enter the lot number in the notes section of the proper operation (s). These items should be recorded at each operation where the lot tracked item is used.
Items that require lot tracking and are on the BOM with a quantity greater than 0, are NOT to be manually lot tracked.  They MUST  have the “Lot Track” box checked in the Items Form, Control Tab (EN1006, Section 4.6.2). 
If an existing part needs to be changed to Lot Tracked and the Lot Track box is not grayed out, you may check it.  If grayed out, stop. Contact the Inventory Control Supervisor as a process needs to be performed before the Lot Track box can be checked.  
A sign off with “BY:_______ DATE:_____/_____/_____ QTY:_______ “along with special “RoHS” requirements  and key characteristics (see section 2.1.3 KCPs, KCCs and RoHS).
For routers that have material issued from a central inventory location, set:

Move Hours = 16
Note: At every Operation in which Manually Tracked  Items are called for, add the item description and signature block. 

Operation 20: Next Work Center (Add operations as product goes to next work center, incrementing by 10 for each operation.)

Operation “XX”: Engineering Test Required (This operation is to occur just prior to final inspection.) 

Operation: Final Inspection, refer to QA15 as a guideline for typical inspection steps.  Additional inspection steps, such as records retention requirements (or omit inspection step) base on product configuration.  Detail Steps, as necessary, should be added to earlier manufacturing operation steps, should not be part of final inspection.   
Note: Final Inspection for Export Controlled Information products (ENG-5555-07) must include instructions to put an Export Controlled Information sticker on the product packaging (blue box, kit case, etc…). PCB Part Number 100-16805-70 is an acceptable sticker, others may be choosen on a case by case basis. Packaging for Export Controlled Information products cannot be transparent.

Note: Final packaging for configured models placed in kit cases, due to cable length, is normally handled by logistics. Final inspection does not handle the kit cases for configured models.


Operation 998:  Product Group Re-Work, e.g., IMIRWK.

Note: 8 hours of move time should be added to this operation to account for stocking; no other times should be added to this operation.
The Last Operation on the router is where the transaction is done to put product into inventory.  Generally the last operation on PCB’s routers is 998. Any product requiring final inspection, should have an operation to route it to the Final Inspection work center (I.E. DFI01) followed by 998.  All other product not requiring final inspection or any other special inspection or stocking instructions, only require the last operation to be 998. 
Note: Each Work Center needs to have an area for sign off by the technician. If multiple operations happen at the work center, then a sign off for each operation needs to be available. The “BY:_______ DATE:_____/_____/_____ QTY:_______” must be added in the notes section. 
Note: Queue Time, Set-Up Time and Control Points must be reviewed for each operation. This is explained later in this procedure in the Creating the Router / Operation Steps from Scratch: section.
Note: The steps and/or operations on the assembly procedure are in accordance with EN1016. For minor specials, modifications to the standard procedure can be specified on the router. All other instructions (welding, etching, TA machining, calibration, sandblast) must be located on the router only and identify the appropriate fixtures by their bubble number.

Note: Products can be built with a modified Bill of Materials if a QA020 (Material Disposition Report/Deviation Notice) is filled out.

2.1.2 Subassemblies Not Stocked in Inventory

Set the Phantom flag for subassemblies that are not stocked in inventory. The operation steps to build phantom assemblies are to be included on the parent router.

2.1.3 KCPs, KCCs and RoHS 
Key Product Characteristics (KPCs): (designated by the symbol: [image: image6.jpg]/N
{xec )



  or the old critical inspection 
symbol: [image: image7.png]


) that are contained in a step of the router need to be defined and always entered into the SPC Program. Reference QAM 7.3 and DD01 for definition and application of KPCs.

Key (Process) Control Characteristics (KCCs): (designated by the symbol: [image: image8.jpg]


) also need to be identified and an additional control added to the router and/or PMS (Planned Maintenance System) for these items. Reference QAM 7.3 and DD01 for definition and application of KCCs.

RoHS: For RoHS compliant products, add the statement “This is a RoHS Compliant Assembly – Use Lead Free solder and station” for each operation where soldering occurs.
2.1.4 X-Ref Jobs

TA1072 must be followed when doing “X-Ref jobs”.

2.1.5 Calibration Steps

Calibration steps come from the E-NMI (SM1008) and any additional requirements imposed by Engineering.

2.1.6 Parts or Assemblies Sent to Outside Vendor

When parts or assemblies are sent to the outside vendor for processing, the following two operations must be added to the router as separate operations (see Figure 6 for an example): 
“MS9999”: This work center indicates that the part is sent out for processing. (Examples include anodized sensors and plated machine parts.) 
Steps under this operation shall include the following:
DELIVER JOB TO APPROPRIATE STAGING AREA
SEND OUT <INDICATE OUTSIDE PROCESS PERFORMED> (e.g., SEND OUT FOR ANODIZING)
ITEM IS EXPORT CONTROLLED INFORMATION, PRINT OUT LG146 AND ENSURE THAT IT IS PACKAGED WITH THE ITEM(S) SUCH THAT IT IS VISIBLE BEFORE THE ITEM (only include on items that are Export Controlled Information (ENG-5555-07))
BY:_______ DATE:_____/_____/_____ QTY:_______

“QC” (Quality Control): This work center indicates the part must be routed through PCB’s receiving inspection department to have any required data entered into our QCS system. Steps under this operation shall include the following:
QUALITY ASSURANCE DEPARTMENT:

BY:_______ DATE:_____/_____/_____ QTY:_______
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Figure 6: Example of Router for Connector sent to Oustide Vendor
Select the “Use Fixed Schedule” box on the “Standards” tab on the “Current Operations” form and enter the vendor lead-time in fixed-schedule hours. 
Note: Each day should be entered as 24 hours. The vendor lead-time may come from a quote or conversation with the vendor. If the lead-time is unknown, enter a default value of 336, which is equivalent to 2 weeks. The outside operation material (PL12345-01, HC12345-01, etc.) must be entered in the respective outside operation to track the service cost. 

2.1.7 Steps for Welding Operation

For welding operation instructions refer to EN1087.
2.1.8 Record Retention

When records are required to be maintained with the scanned job router, add applicable form numbers to Final Inspection step (final assemblies) or as the last router step (sub-assemblies). Add this wording to the final inspection step:

“Scan the following records with the job router:


(TAxxx Record)


(QAxxx Record).”

2.2 Creating the Router / Operation Steps from Scratch:


In an effort to insure the BOMs/Routers are accurate, the Production Department has a formal mechanism for providing feedback and tracking the errors. If Production finds an error, this is documented on an Material Disposition Report/Deviation Notice (QA020).

2.2.1 Procedure for Creating Router/Operation Steps from Scratch 

A router can be created from scratch or copied from a similar design by entering information using the following steps: 
Step 1: Open the “Current Operations” form in the BSD and enter the item you are creating the router for. Click the “Create New Object” icon to enter a new operation step.

[image: image10.png]Infor ERP SL (pcb) - Current Operations

Eorm  Actions  Edt

vew

window

Help

EEHaARDX3EA LN BABRRE®IB e @508 002BR8N

wielcome

Stage Environment | Sign Ot

S Cunent Opeations ©
Curront Opaatons ©

Jaiojdx3

Item

282401
262401
262401
262401
262401
262401

Itom: (2182401

MAIN ASSEMBLY (358401/NC)

Operation: [ 1 we[300

|ACCELERATION ASSY.

dads

262401
262401
262401
262401
262401
262401
262401
262401
262401
262401
262401
262402
262402
262402
262402
262402
262402
262402

Use Fised Schedule

Fived Sched Hours:

Machine Hours per Piece

000

Fieces per Machine Hour

Labor Hous pes Piece

000

Fieces per Labor Hour

Sched Diiver. Labor
Fun Duratior: 000000

Batch Defirtion: |

Haurs
Move:

Queve Time:

Selup:

Fiish:

Ofset.

Effective:

Obsolete:

000

000

00

000

Use Dffset Hours

Backllush:

Batch Definition (Current Operation 1 of 200)

NOTES MU enLIs someredi 1T





Figure 7: Location of Create New Object Icon on Current Operations Form
Step 2: Enter “10” in the “Operation” field (or select “10” from the pull-down menu where available).

Step 3: In the “WC” field, select from the pull-down menu the work center where the work will be performed.
Step 4: Fixed Scheduled Hours are used for outside operations. See section 2.1.6 Parts or Assemblies Sent to Outside Vendor in the Routers / Operation Steps Structure: section.

Note: For outside services 336 hrs (2 weeks) is typically used.  Fixed Scheduled Hours should be equal to the vendor lead time plus transit time to and from the vendor.  Typically, the work center MS9999 is used, however other work centers may be used for other sites (LT9999 is used in Farmington).
Step 5: If entering an Operation Step that contains labor, selected the desired cost rate as “Labor Hours per Piece (LHP)” or “Pieces per Labor Hour (PPLH)”. Enter the number in the field provided. (If labor hours are less than 1 hour, enter as a decimal. Example: 20 minutes = 20 divided by 60 = .33 hours.)
Note: Use caution when selecting LHP vs. PPLH, for a wrong entry could significantly alter the true cost on this product.
Note: When selecting LHP vs. PPLH, choose the unit that will depict the most useful number.
Note: For Welding and Etching work centers: set Pieces per Labor Hour” (PPLH) to 35 PPLH for each Etching or Welding operation. These factors are per weld or per etch, so divide by the number of discrete welds or etches per part and enter the resulting value into the pieces per labor hour field. 

Note: If Gross Leak Test per TA1012: set Pieces per Labor Hour” (PPLH) to 77 PPLH.
Step 6: Enter “Move” time as appropriate for all non-touch times between operations. Move time is used to schedule time for movement between the previous operation and the current operation in the routing. 
Note: In Syteline, Move time start when the last operation is completed, and ends when time expires or the next operation is opened.
Note: Move time for all work centers will default to 2 hrs.  This Move time should be added whenever a procuct changes work centers.  (i.e. if consecutive operations have the same work center, only the first operation in that work center will have move time).
Note: The first operation after inventory control should be set to 8 hrs. 

Note: Use a maximum of 8 hours of move time per day.

Note: For calibration work centers and work centers beginning with PS, a minimum of 4 hr should be used.

Note: Engineering should change the move time if they know the time is different outlined above. 

Step 7: (Queue Time: Should not be used.)

Step 8: (Set Up Time:Typically used only in the machine shop and crystals!)

Note: When using set up time, make sure the appropriate lot size is set properly by the responsible planner/operations manager.

Step 9: Enter “Finish” time as appropriate for all non-touch times during operations. Finish time is used to schedule time when product is idle between current operation and the next operation in the routing. 

Note: In Syteline, Finish time starts when the current operation is completed, and ends when the time expires. The process that requires the finish time should be located at the end of the operation, but is not required).  
Note: Finish time for all work centers will default to 0 hrs. 

Note: Engineering should change the Finish time if they know the time is different than 0 hrs. 

Note: Use a maximum of 8 hours of Finish time per day.

Examples:

An epoxy with 12 hour cure would use 8 hours.
100 hours of temperature cycle testing would use 34 hours:

(100 hour ÷ 24 hours/day × 8 hours) = 33.33 hours rounded to 34 hours 

Step 10: Control Points flag is set by planning and operations in the work center settings where a BSD transaction is required. In General, all other work centers should be left at their default settings. Special customer contractual obligations may require engineering to change the default setting for certain items.
Step 11: Default backflush is set by planning and operations in the work center settings.  Backflush “Neither” indicates labor tracking is required at this operation. Backflush “Both” indicates labor tracking will not be performed. Special customer contractual obligations may require engineering to change the default setting for certain items.

Step 12: Click on the “Note” icon to add the specific details associated with each operation step. This is the information that the technicians will follow when building a part (e.g., “RoHS” solder station statement) and needs to include the Technician signoff area: “BY:_______ DATE:_____/_____/_____ QTY:_______”
Note: Leave a blank line between the last note and the technician sign off area to allow sufficient room for employee stamps.

Step 13: After entering all of the necessary information, click the “Save” icon to save the data for that operation.

Step 14: Repeat this series of steps to add operations as the part moves from work center to work center. See note below when you get to the last step.
Note: All routers should end with Operation 998.

The following settings should be used for Operation 998:

· WC = General Product Group Rework Code

· Crew Size = 1.00                                                                    

· Control Point Flag = On

· Use Fixed Sched Flag = Off

Engineering is responsible to change the move hours for operation 998 from 0 hr to 8 hr for Model level routers only. This is done to allow planning time to get jobs to the floor. 

2.2.2 Program Models Requiring Certification to Specific Procedure 

When Program Models require assembly technician(s) to be certified to specific procedures; add the following signoff notes to the first operation after operation 5 along with a listing of specific procedure(s):

“This product requires all assembly technician(s) building this job to be certified to the following procedure(s), _________. Attach a copy of the latest ‘Training Database Report by Course’ to this job packet.

Production Manager (or delegate):_______ DATE:_____/_____/_____ QTY:_______
At every operation in the router that references any of these specific procedures, add the following signoff note:

“This product requires all assembly technician(s) building this job to be certified to the following procedure(s), ____. Review the attached ‘Training Database Report’ and verify you are certified to complete this operation.

BY:_______ DATE:_____/_____/_____ QTY:_______
2.2.3 Program Models Requiring Verification of Training to Specific Procedure 

For Program Models that require verification of service operator training to specific procedures (e.g., Laser Welding), notify the Human Resources or Quality Department to add these procedures to the service operator training matrix.

Note: If a revision is made to any of these program specific procedures, the Quality Manager must be notified to assure the training matrixes are updated.

+
Note: A report listing which technicians are trained to specific procedures can be obtained by requesting a copy of the “Training Database Report by Course” through the Human Resources Department.

2.2.4 Calibration Testing 

All calibration testing, including completing any applicable ATP (Acceptance Test Procedure) will be the responsibility of the Calibration Technician(s).

2.2.5 Program Sensors Step(s) 

All program sensors, must have a router step added (allowing PCB’s Quality Department to review all documentation for accuracy and compliance) as the last Final Inspection task prior to any document copying, Source Inspection or shipment.  Add the following signoff note: 


“Manufacturing and Test Documentation Review Complete per QC1078: 

Quality Dept Representative:_______ DATE:_____/_____/_____ QTY:_______"
Note: Work center = DFI01 Final Inspection

Additionally, all sensors requiring Source Inspection must have router steps added (allowing PCB’s Quality Department to conduct Pre-Source Inspection product and documentation review) to coordinate Source Inspection and to document Source Inspection activities.  Add the following signoff notes as the last Final Inspection task:

 “Pre-Source Inspection Compliance Review / Source Inspection Request: 

Quality Dept Representative: _______ DATE:_____/_____/_____ QTY:_______
Source Inspector Identification and Product Inspection:

Source Inspector 1: _______ DATE:_____/_____/_____ QTY:_______
Source Inspector 2: _______ DATE:_____/_____/_____ QTY:_______
2.2.6 New Model Level Routers 

All new model level routers should initially include an “Engineering Test Required” operation. The intent of this operation is to insure that Engineering and Sales have the opportunity to completely verify the first build of the sensor prior to shipment to the customer. The purpose of this “prior to shipment review” is for Sales and Engineering to review as necessary all data, documentation, design inputs, specification verification and physical units in order to validate all manufacturing processes (including welding, etching, finishing, etc.) and the product prior to shipment to the customer. The following settings should be used for this operation:
· WC = “ENG” is used in Depew, “LTENG1” is used in Farmington Engineering Test.

· Obsolete Date = Recommended to be 4 weeks after the date the router was entered.

· Move Hours = Hours required to complete testing (1 business day = 8 hours).

· All other fields should default to the appropriate settings.

In the Notes section, enter the following text: 

“ENGINEERING EVALUATION REQUIRED. ROUTE TO: (your name and extension) FOR EVALUATION.
ENG:____________________ DATE:_____/_____/_____

SALES:__________________ DATE:_____/_____/_____

 (and “QC APPROVAL:___________ DATE:_____/_____/_____” ,if item is a program order).

The blank spaces are to be signed by the Product Manager as well as the Lead or Project Engineer prior to returning the product and paperwork to the manufacturing area.

2.2.7 Printing Router 

To print the router open the “Item Current Routing Report” form (Figure 8).
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Figure 8: Item Current Routing Report Form
ABC Code: Leave as default.

Notes: As a default, only check Operation and Material Notes.

· Operation – Notes attached to the router operation.

· Material – Notes attached to the material.

· Internal – Notes attached to the items with the internal flag checked.

· External – Notes attached to the items with the external flag checked.

Page Between Operations: Normally not checked.

Print Item Materials: Check to have current material printed with operations.

Display Reference Fields: Check to display bubble numbers associated with material.

Effectivity Dates: Used to remove obsolete material and/or operations by date.

Display Report Header: Recommended to leave unchecked.

Item: Enter starting and ending range of items to be displayed.

Product Code: To display current routing report by product code range.

Operation: Display only the operation(s) from the entered Items or Product Code.
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Figure 9: Item Current Routing Report Preview
Note: If you click “Preview” and the report does not open in Adobe Reader, your Adobe Reader Internet Settings need to be changed. In Adobe Reader, select Edit > Preferences to open the Preferences dialog, then select the “Internet” category and “Uncheck” the “Display PDF in browser” checkbox.
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Figure 10: Adobe Reader Internet Settings; NOTE: contact IT help desk to additional assistance
2.3 Copying BOMs and/or Router / Operation Steps from an Existing Part:

When a new BOM or Router is being created and it closely resembles an existing BOM or Router, the simplest approach is to copy the existing information to the new part. Then the materials or notes in each operation can easily be modified.

Note: Special care must be taken to prevent overwriting existing data. Verify that the BOM and Router do not exist for the “copy to” item.

2.3.1 Steps to Copy BOM/Router/Operation Steps from Existing Part 

Step 1: Open the “Copy Routing BOM” form:
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Figure 11: Copy Routing BOM Form
Step 2: In the “From” fields:
· “Category”: Select one category:

· “Current”: Copy from a current Router and BOM.
· “Job”: Copy from an existing Job Router and BOM.
· “Actual Job”: Same as “Job” but includes any added material or operations added after the job was released.
· “Estimate Job”, “PS Item” and “PS Release” are not used. 

· “Job”: Enter job number if “Job” or “Actual Job” is selected as the category.
· “Sched ID”: Only applies if “PS Item” or “PS Release” is selected as the category. (Not used.)
· “Item”: Enter Item number when “Current” is selected as the category. Auto populated for all other categories.
· “Release”: Only applies to “PS Item” and “PS Release” and is not used. 

· “Revision”: Automatically populated.
· “Start Op” and “End Op”: Enter beginning and ending operations you want to copy. Used to limit portion of router to be copied.

Step 3: In the “To” field:
· “Category”: Select one category:

· “Job”: Copy to an existing Job Router and BOM.

·  “Current”: Copy to a current Router and BOM.

·  “Estimate Job”, “PS Item” and “PS Release” are not used. 

· “Job”: Enter job number if “Job” is selected as the category.

· “Sched ID”: Only applies if “PS Item” or “PS Release” is selected as the category. (Not used.)

· “Item”: Enter Item number when “Current” is selected as the category. Auto populated for all other categories.

· “Release”: Only applies to “PS Item” and “PS Release” and is not used.

· “After Oper”: Enter operation number to insert copied router and BOM when inserting and not replacing.
· “Effective”: Enter date to prevent copying obsolete material and/or operations.

· “Copy to PS Release BOM”: Only applies to “PS Item” and is not used.

Step 4: The “Copy indented BOM” field should be left at its default of “No”.
Step 5: The “Extend By Scrap Factor” field should be left at its default of “No”.

Step 6: In the “Option” field, select one option:

· “Insert Range”: Adds new operations and material to existing operations. New operations will follow the operation entered in the “After Oper” field above.
· “Replace Range”: Overwrites existing operations with the same numbers as the starting and ending operations entered above. If there are operations outside of the specified range, they will remain.
· “Delete All”: Removes all existing operations and replaces them with operations from the source Router and BOM.
Step 7: “Labor”, “Material”, “Both”: Select one option:

· “Labor”: Copies only existing operations entered above.
· “Material”: Copies only material from the operations entered above.
· “Both”: Copies both operations and material from the operations entered above.
Step 8: “Copy Doc-Trak”: Check to have any Doc-Trak information copied.

Note: Normally the “Copy Doc-Trak” option is not checked because Doc-Trak components are attached to the BOM components. However, it should be used to Doc-Trak phantom assembly BOMs.
Step 9: After copying, be sure to go back to the item you copied information to and make the necessary modifications to the new BOM and/or Router.
Create New Object Icon
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